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ABSTRACT:
Introduction – Plant volatiles (PVOCs) are important targets for studies in natural products, chemotaxonomy and biochemical 
ecology. The complexity of PVOC profi les often limits research to studies targeting only easily identifi ed compounds. With the 
availability of mass spectral libraries and recent growth of retention index (RI) libraries, PVOC identifi cation can be 
achieved using only gas chromatography coupled to mass spectrometry (GCMS). However, RI library searching is not typically 
automated, and until recently, RI libraries were both limited in scope and costly to obtain.
Objective – To automate RI calculation and lookup functions commonly utilised in PVOC analysis.
Methodology – Formulae required for calculating retention indices from retention time data were placed in a spreadsheet 
along with lookup functions and a retention index library. Retention times obtained from GCMS analysis of alkane standards 
and Koeberlinia spinosa essential oil were entered into the spreadsheet to determine retention indices. Indices were used in 
combination with mass spectral analysis to identify compounds contained in Koeberlinia spinosa essential oil.
Results – Eighteen compounds were positively identifi ed. Total oil yield was low, with only 5 ppm in purple berries. The most 
abundant compounds were octen-3-ol and methyl salicylate. The spreadsheet accurately calculated RIs of the detected 
compounds.
Conclusion – The downloadable spreadsheet tool developed for this study provides a calculator and RI library that works in 
conjuction with GCMS or other analytical techniques to identify PVOCs in plant extracts. Copyright © 2009 John Wiley & Sons, Ltd.
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Introduction
Plant volatile organic compounds (PVOCs) are commonly identi-
fi ed using gas chromatography (GC) in combination with (1) 
mass spectroscopy (MS) for spectral matching, (2) fl ame ionisa-
tion detection (FID) for quantifi cation of peak areas from diverse 
unknowns and (3) retention index (RI) matching. A single plant 
extract may contain hundreds of structurally similar terpenoids 
that produce highly similar mass spectra. Thus, compound match-
ing by mass spectrometry alone is error prone. Matching by 
comparing retention times with those of standards run on the 
same system can be impractical, since many plant compounds 
are not commercially available. Published retention indices are 
more suitable than retention times for comparison across dif-
ferent chromatographic systems. The combined matching of mass 
spectra and retention indices can facilitate positive identifi cation 
of more than 100 compounds from a single plant extract with 
only a few chromatograms (Tellez et al., 1997a).

While mass spectral library search capabilities have been 
standard components of software sold with GCMS systems for 
decades, standard libraries of retention indices have only recently 
been added to major chemical databases (NIST Mass Spec Data 
Center, 2005a, b; Babushok et al., 2007). Hence, retention index 
library matching has not traditionally been included as a feature 
in major chromatography software systems.

For several years, our research group has examined PVOC 
profi les in conjunction with livestock herbivory and general arid 
land ecology (Fig. 1). Throughout these studies, we have relied 
heavily on Robert Adams’s mass spectral libraries, which include 

both mass spectra and retention indexes (Adams, 2001, 2007). 
To automate retention index calculation and matching in con-
juction with this library, we developed a simple spreadsheet tool 
which uses functions contained within Microsoft Excel® and 
OpenOffi  ce Calc (OpenOffi  ce.orgTM v. 3.0.1) to calculate retention 
indices of unknowns by comparing them with retention times 
of hydrocarbon alkanes analysed with the same separation 
method. After calculating retention indices, the tool searches 
input libraries, returning compounds with retention indices near 
those of the peak in question. An input library consisting of 
retention indices reported for PVOC compounds examined in 
the PVOC analyses referenced in Fig. 1 is included. Additional 
compounds may be added to this library by the end user.

Although similar tools are increasingly likely to be integrated 
within modern chromatography software systems, we believe 
this tool will be of use to research, quality control and academic 
laboratories that lack access to the latest chromatographic 
software and systems.
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Here we demonstrate the utility of our RI Calculator tool by 
determining retention indices of volatile compounds associated 
with the essential oil of Koeberlinia spinosa Zucc. (‘crucifi xion 
thorn’, KOSP), a thorny, nearly leafl ess arid land species noted 
for upward growing, putatively hydrotropic roots (Gibbens and 
Lenz, 2001). In doing so, we demonstrate the utility of the RI 
Calculator for identifying volatiles from complex profi les for 
diverse applications.

Experimental
Plant sampling, oil extraction and instrumental analysis

KOSP samples were collected from the JER near Las Cruces, New 
Mexico at approximately N 32°36.607 latitude and W 106°33.384 
longitude, 1726 m above sea level (Fig. 1). The current year’s 

growth (approximately 1 Kg fresh weight) was removed from 
randomly selected branches of 10 individual plants and com-
bined to form composite samples. Composited samples were cut 
by hand to lengths not exceeding 2.54 cm, and triplicate 20 g 
aliquots of this material were extracted by steam distillation as 
previously described (Lucero et al., 2005). Briefl y, chopped green 
tissue was placed in a round-bottom fl ask containing 100 mL of 
distilled water and attached to a Likens–Nickerson distillation 
apparatus, where it was distilled for 6 h. Pentane (10 mL) was 
added to the U-tube and to a pear-shaped collection fl ask. The 
pentane was maintained at 60–70°C throughout the 6 h distil-
lation. Following distillation an additional 8 mL of pentane was 
used to rinse the apparatus. Pentane fractions were combined, 
dried over anhydrous magnesium sulphate, and fi ltered. The 
solvent was removed using a rotary evaporator under reduced 
pressure.

Fruit was harvested from the same plants at both immature 
(green) and mature (purple) stages. Whole berries were steam 
distilled in the same manner, except that only 10 g of tissue 
were used in each replicate. Oil retrieved from each distillation 
was diluted in 100% ethanol for GCMS analysis, or injected as 
pure oil for GC-FID analysis.

Solid-phase microextraction (SPME) analyses was conducted 
by placing 0.5 g of fi nely chopped tissue into 4 mL screw-top 
vials sealed with poly(tetrafl uoroethylene) (PTFE)/silicon septa 
(Supelco®). The vials were equilibrated at 30°C for 2 h and then 
exposed to 1 cm of a 100 µm PDMS fi ber (Supelco®), for 10 min. 
The fi bre was immediately injected into the appropriate gas 
chromatograph inlet to a depth of 3 cm. The fi bre remained in 
the injector for 5 min to remove residual volatiles, and blank 
runs were performed after each sample.

GCMS analysis was performed using a Varian model 3400 GC 
with a DB-5 column (30 m × 0.25 mm fused silica capillary column, 
fi lm thickness 0.25 µm) coupled to a Finnigan ion trap mass 
spectrometer (EI, 70 eV). Helium (1 mL/min) was used as a carrier 
gas, and injector and transfer line temperatures were set at 220 
and 260°C, respectively. The initial column temperature was 60°C, 
and a linear temperature increase of 3°C/min was programmed 
into each 65 min run. When injecting oils, a series of large (500 ng) 
to small (50 ng) injections were used to validate retention times 
for both low- and high-concentration components.

To validate peak area percentages revealed on the total ion 
chromatogram, the oil was also analysed using a Shimadzu 
GC8APF equipped with a fl ame ionisation detector and fi tted for 
use with capillary columns. A split/splitless injector was used, 
and the column type, temperature gradients, and helium fl ow 
rates were identical to those used for the GCMS analysis. The 
injector temperature was 250°C.

Dry matter percent was determined by drying triplicate, 
2 g samples of chopped tissue at 60°C for 24 h. Oil yield was 
reported as µg oil/gram dry tissue.

Retention time and retention index matching using the ‘RI 
Calculator’

To facilitate repeated calculation of retention indices, a standard 
containing 5 ng/µL each of 18 n-alkane hydrocarbons (heptane 
through n-pentacosane) was run prior to analysis of essential oil 
extracts using the instrument parameters described above. The 
retention times at which each hydrocarbon alkane standard 
eluted was recorded on the Hydrocarbon RTs page of the ‘RI 
Calculator’ spreadsheet (Fig. 2). A read-only copy of the 

Figure 1. Volatile compounds extracted from shrubs growing on the 
USDA-ARS Jornada Experimental Range, located in the southwestern 
USA, have provided a library of retention indices against which newly 
analysed volatiles can be compared. Sample sites for each species are 
indicated with the NRCS species codes as follows: Ceanothus greggii Gray 
(CEGR) (Lucero et. al., 2009); Ceratoides lanata (Pursh) J. T. Howell var. 
subspinosa (Rydb.) J. T. Howell (CELAS2) (Lucero et al., 2004); Chryso-
thamnus pulchellus (A. Gray) Greene (CHPU4) (Tellez et al., 1998); Dalea 
formosa Torr. (DAFO) (Lucero et al., 2005); Dyssodia acerosa DC. 
(DYAC) (Tellez et al., 1997a); Koberlinia spinosa (KOSP), Flourensia 
cernua (FLCE) (Tellez et al., 1997b) and Psorothamnus scoparius (A. Gray) 
Rydb. (PSSC6) (Lucero et al., 2003).
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spreadsheet (supplemental data) can be opened in recent ver-
sions of Microsoft Excel® or Open Offi  ce CalcTM.

Mean n-alkane retention times obtained by separating stan-
dards as described above are included in the spreadsheet as refer-
ence points. This separation method allows the user to compare 
results to retention indices reported in Robert Adams’s database 
of essential oil retention indices (Adams, 2001), or to retention 
indices determined by our group and included in the calculator. 
A scatter plot of hydrocarbon numbers against retention times 
appears on a graph within the spreadsheet, along with a linear 
plot and the R2 value of the linear regression. This graph helps to 
assess linearity of the n-alkane retention times. Outlier points or 
R2 values signifi cantly less than 1 may indicate problems with the 
chromatographic system or with compound identifi cation. 
Our group routinely achieves R2 values greater than 0.99 with the 
standards and methods described herein.

Once the n-alkane retention times and linearity relationships 
are properly determined, the next step is to transfer the reten-
tion times of unknown compounds, separated with the same 
instrument parameters from the GC output to the appropriate 
column (A for seconds, B for minutes) on the ‘sample data entry’ 
page (Fig. 3). If GC retention times are reported in minutes, they 
can be pasted into the ‘minutes’ column, and the seconds will 
be calculated automatically. If the retention time is provided in 

seconds, values can be pasted directly into the ‘seconds’ column, 
overwriting the minute conversion formulae contained therein. 
In this case, the minute column is ignored, since it is not needed 
for subsequent calculations. The column void time must be man-
ually entered in the upper right-hand corner.

Remaining spreadsheet columns were hidden to simplify 
viewing. The hidden columns contain lookup, matching and 
index formulae used to identify retention times of the nearest 
alkanes (taken from the Hydrocarbon RTs page), and the formula 
(A) used to calculate retention indices. In order to review these 
formulas, a user can reveal hidden columns simply by selecting 
Format > Columns > Unhide from the top menu.

Formula A:

RI
RT RT

RT
unknown smalleralkane

la

=
+ − − −100 * [log( ) log( )]

log(

n v v

rrger alkane smalleralkaneRT− − −v v) log( )

where n = the number of C in the smaller alkane; RTunknown = the 
retention time of the unknown in seconds; v = column void 
time; RTsmaller alkane = the retention time of the smaller alkane; and 
RTlarger alkane = the retention time of the larger alkane.

The results are viewed by selecting the ‘Results’ tab from the 
bottom of the workbook. The output shows the RI calculated for 

Figure 2. The HYDROCARBON RTs page of the RI Calculator workbook. Retention time values from hydrocarbon standards can be pasted into either 
column C (seconds) or column D (minutes). New values can quickly be compared with retention times obtained from previous runs, so that deviations 
can be identifi ed. The R2 value of the line associated with the scatter plot at the bottom of the page will illustrate the linearity of the retention time vs 
hydrocarbon number plot, which should exceed 0.99. This fi gure is available in colour online at www.interscience.wiley.com/journal/pca
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each unknown retention time entered. In addition, the columns 
to the right show the compound obtained from the page ‘RI 
Library’ with a retention time nearest to the unknown. The pub-
lished reference in which the RI for the matching compound 
was determined is shown, along with the USDA-NRCS Plants 
Database symbol for the plant species in which the library com-
pound was identifi ed (Fig. 4).

Compound identifi cation

Positive identifi cation of organic compounds generally requires 
application of two or more analytical techniques. In PVOC ana-
lysis, combining mass spectral and retention index matching is 
convenient since both can be carried out with a single chromat-
ographic run. In the absence of spectral analysis, or when several 
compounds have similar spectra and retention indices on a given 
column, matching of retention indices determined on columns with 
diff erent stationary phase polarities may suffi  ce. In the current 
experiment, mass spectral matching was obtained using MagnumTM 
software. A positive match required both a spectral fi t score of 
≥950 and a retention index within fi ve units of reported values.

Some judgement on the part of the analyst is necessary for 
determining acceptable variation between reported and observed 
retention indices. For example, compounds that are poorly retained 

(RIs < 850) on the column are likely to show more variable reten-
tion times than those with indices between 850 and 1900 using 
the DB-5 column described above. Late eluting compounds (RIs 
> 1900) may undergo band broadening which may cause varia-
tion in assessment of retention times. Thus, a 5 unit diff erence 
between reported and observed retention indices would be 
more acceptable for very early or very late eluting compounds 
than for compounds with intermediate retention times.

A second factor to consider when evaluating diff erences 
between reported and observed retention times is the diff erence 
between reported and observed retention times for other 
compounds within the same extract. For example, if an extract 
contains tricyclene (RI = 930), a-pinene (RI = 942), and an unknown 
compound with a spectra matching camphene and a retention 
index of 950, the unknown is not likely to be camphene. While 
the calculated retention index is within 2 units of the 953 index 
reported for camphene in Dalea formosa extracts (Lucero et al., 
2005), the indices observed for tricyclene and a-pinene in the 
same extract are higher than the mean retention indices reported 
for those compounds in other literature (Tellez et al., 1997b; Adams, 
2001; Medina et al., 2005); hence, one would expect camphene, 
which elutes within a minute of tricyclene and a-pinene, to also 
have a slightly higher-than-average index. The various retention 
indices reported for compounds identifi ed in various plant extracts 

Figure 3. The Sample Data Entry page of the RI Calculator. Columns C–N, used strictly for calculation 
of values derived from the entries, are hidden. They can be viewed by selecting Format > Columns > Unhide 
from the top menu. This fi gure is available in colour online at www.interscience.wiley.com/journal/pca
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identifi ed on the JER can be seen on the ‘RI Library’ page of the 
RI Calculator (see Supporting Information).

Quantitative analysis

Relative peak areas eluting from FID chromatograms with reten-
tion indices matching those of compounds identifi ed in parallel 
GCMS chromatograms were used to estimate micrograms of 
compound per gram dry plant tissue (ppm).

Results and Discussion
Essential oils of Koeberlinia spinosa

KOSP is the only species within the genus Koeberlinia. The nearly 
leafl ess shrub produces photosynthetic stems and sharp thorns 
which eff ectively deter large mammals. However, brightly colored 
berries which appear in the summer are utilised by small herbivores, 
including birds and insects. The absence of leaves, which are the 
source of many PVOCs in most plants, suggests low overall vola-
tile production.

Triplicate distillations of the photosynthetic, leafl ess stem 
tissue yielded less than 0.1 ppm (µg oil/g dry matter). Yields for 
the green and purple berries were 1 and 5 ppm, respectively. 
Low yield from stem tissue prevented direct analysis of oil samples. 
Therefore, SPME headspace analysis was used to determine the 
volatile composition. SPME generally provides greater sensitivity 
for qualitative analysis than steam distillation, but can be more 

diffi  cult to analyse quantitatively (Lucero et al., 2006). For this 
reason, the amounts of volatiles detected in stem extracts are 
reported simply as peak area percentage (Table 1).

The RI Calculator in combination with mass spectral and 
retention index libraries facilitated identifi cation of 15 compounds 
in green berries, six compounds in purple berries and two com-
pounds in the stem essential oil from Koeberlinia spinosa essential 
oil. Seven of these compounds have not been detected in other 
species collected from the JER (Table 1). Thirty-seven additional 
compounds were reproducibly detected, but could not be posi-
tively identifi ed (data not shown). Most of these were small 
peaks with low signal-to-noise ratios, thus poor spectral purity 
prevented matching to library compounds. However, berries also 
contained several large, spectrally impure peaks with retention 
indices of 2568, 3239, 3301, 3404 and 3740. These fi ve peaks 
comprised 20 and 35% of the total FID peak areas for green and 
purple berries, respectively, but impurities prevented spectral 
matching and positive identifi cation.

Not surprisingly, oil composition diff ered by tissue and by 
maturity. Only two clearly identifi able compounds, n-octanol 
and n-decanal, were observed in stem tissues. Both of these 
compounds were also present in the green berries, which pro-
vided the most complex mixture of detectable volatiles. Three 
compounds, methylbenzoate, methyl salicylate and b-eudesmol 
were present in both green and purple berries. All three of these 
were more abundant in the green berries. Compounds identifi ed 
only in the purple berries included 6-methyl-5-hepten-2-one, 8- 
a-acetoxyelemol and hexadecanol.

Figure 4. The Results page of the RI Calculator. Unknowns, listed by retention time, are shown with calculated RIs. In addition, the library compound with 
the nearest RI is provided, along with the USDA-NRCS species code of the source plant in which the library compound was previously detected. References 
describing identifi cation of the library compound are shown. This fi gure is available in colour online at www.interscience.wiley.com/journal/pca



A Retention Index Calculator

Phytochem. Anal. 2009, 20, 378–384 Copyright © 2009 John Wiley & Sons, Ltd. www.interscience.wiley.com/journal/pca

383

Utility of the RI Calculator

The RI Calculator spreadsheet eff ectively simplifi ed the task 
of determining retention indices for unknown compounds. The 
lookup feature, which compares calculated RIs with those previ-
ously reported, was useful for narrowing the list of possible 
spectral matches to those that also had matching RIs. However, 
because the lookup feature only identifi es the nearest library 
compound with an RI lower than the reported RI, manually 
scrolling through the library for similar RIs and checking outside 
references for plant volatile retention indices was still necessary.

The ability to identify volatile compounds in complex GC 
chromatograms with nothing more than spectral library and 
retention index matching is neither new nor novel, but is 
arguably underutilised in chemotaxonomy and other areas of 
chemical ecology (Adams, 2001). Retention indices, introduced 
50 years ago, are robust constants that convey distinct informa-
tion about the compounds they describe (Kováts, 1958). Yet, unlike 
chemical mass spectra, for which reference libraries abound, 
retention index databases have been slow to catch on. Robert 
Adams’s mass spectral library of plant compounds is one of only 
a few that included retention indices with its early editions 
(Adams, 2001).

It is possible that hesitancy to incorporate retention indices 
with databases serving multiple users arose due to the rapid 
changes in chromatography during that time. When Kováts fi rst 
proposed use of retention indices, his research was based on 
compounds separated isothermally on packed GC columns. 
However, more powerful temperature gradient separations and 
fused silica capillary columns were rapidly becoming the industry 
standard. Hence, modifi cations to retention index determina-
tions had to be incorporated (Kováts, 1965). In the decades that 
followed, numerous new stationary phases became available for 
chemical separations. Because phase material strongly infl uences 
the retention index of a compound, the rapid development of 
novel phase technologies may have temporarily discouraged 
eff orts to invest in development and publication of retention 

index libraries, which would only be of value to end users who 
chose the same phase. However, the added value of retention 
properties for compound identifi cation is indisputable (Ettre, 
2003; Harangi, 2003). Retention index data for numerous PVOCs 
have been available in commercially available libraries for many 
years (Adams, 2001). More recently, retention index data have 
been added to readily accessible public databases such as the 
NIST Chemistry WebBook (Babushok et al., 2007).

The retention index library off ered in the RI Calculator (Sup-
porting Information) can be readily expanded to include addi-
tional compounds of interest to the end user. To expand the 
library, simply add new compounds with reported retention 
indices to the list on the workbook sheet entitled ‘RI Library’. 
The entire list should then be selected and re-sorted so that all 
compounds are listed in order by retention index, followed by 
compound name. Finally, to ensure that lookup commands 
reference the expanded list of entries, choose Insert > Name > 
Defi ne from the menu on the top of the page, and select the 
name ‘RILIST’ from the ‘Defi ne Name’ box that appears. While 
RILIST is selected, drop to the ‘refers to’ box and expand the 
range of cells in column A to include the new entries. Next, 
select the name ‘RILIB’ and repeat this process, selecting a new 
range of cells from columns A–D to include the new library 
entries. Now, all added compounds will be searchable.

The RI Calculator presented here evolved over the course of 
several studies of essential oil compositions. Users interested in 
volatiles with lower molecular weights will need to replace the 
hydrocarbon standards listed on the Hydrocarbon RTs page of 
the calculator with appropriate standards having molecular 
weights above and below the molecular weights of their com-
pounds of interest. Such compounds are not represented in the 
existing RI library, but could be added by the end user as 
described above. The lookup function for matching calculated 
retention indices to those previously reported is limited, in that 
it only returns the lowest-value compound from the library list 
that meets the ‘closest hit’ criteria. A solution to this weakness 
could be obtained by building the tool in a database, rather 

Table 1. Koeberlinia spinosa volatiles identifi ed by RI and spectral matching. Asterisks identify compounds that have not previ-
ously been observed in plant species from the Jornada Experimental Range

Identifi ed compounds RI ppm in green berries ppm in mature berries Percentage area stem

Octen-3-ol* 981 0.537
6-Methyl-5-hepten-2-one 983 0.047
6-Methyl-5-hepten-2-ol* 994 0.018
p-Methylanisole* 1021 <0.001
n-Octanol* 1072 0.010 0.89
Methybenzoate 1091 0.068 0.012
Methyl salicylate 1191 0.114 0.011
n-Decanal 1204 0.021 0.47
(E)-2-decenal 1262 0.014
2E,4E-decadienal* 1314 0.026
Geranyl acetone* 1453 0.013
Elemol 1549 0.042
Eremoligensol* 1629 0.024
Muurolol 1641 0.024
b-Eudesmol 1651 0.055 0.013
8-a-Acetoxyelemol* 1789 0.009
Hexadecanol* 1879 0.034
Methyl hexadecanoate* 1927 0.041
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than on a spreadsheet. For example, in Microsoft Access®, all 
matching compounds could be displayed as a drop down list, 
and the best match could be selected. However, we fi nd a 
greater number of users familiar with spreadsheets than with 
databases. Hence, we felt the spreadsheet-based application 
would be easier for individuals to modify and adapt to their 
unique laboratory needs. The utility of the spreadsheet in 
OpenOffi  ce Calc is an added benefi t, since OpenOffi  ce Calc is 
open source software freely available to the general public. 
Because the authors utilised the spreadsheet in Microsoft Excel®, 
it has been less thoroughly tested in OpenOffi  ce Calc. Spread-
sheet copies available as Supporting Information are saved in a 
read-only format. Users’ data that is entered can be saved by 
renaming the fi le using the ‘Save As’ function. This prevents 
overwriting the original formats and formula.

Supporting information

Supporting information can be found in the online version of this 
article.
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